
We came, we saw, we conked out.

Excel Virtually Global, our annual Excel / Power BI event now being held for its seventh 
successive year in its different guises, has been and gone.  With over 40 presenters and 
hosts, we learned a lot about Power Pivot, Power Query, Power BI, PowerPoint, Excel and 
financial modelling.

The presenters waived their magic and engaged the audience.  If you missed it, it’s still 
possible to watch many of the sessions.  Simply go to bit.ly/EVG2022Videos (please note 
this is case sensitive) for further details.

Please don’t forget, this event was for charity.  We’d love you to donate to a worthy cause 
of your choice and just let us know by filling in the form using the QR code:  

or else use the link bit.ly/EVG2022Charity 
(this is case sensitive and should be typed 
in “as is”). 
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Liam Bastick, Managing Director, SumProduct

Excel Virtually Global This Month  - Been There, Done That, Bought the T-Shirt…

As the end of the year gets closer we bid adieu to our eighth conference, Excel Virtually 
Global 2022.  I hope you attended and found it worthwhile.  It will be back in 2023 for sure.  

Other than that it’s business as usual.  With heads down and full steam ahead, we have another Beat the Boredom Challenge to keep 
your Excel brain nimble, alongside fellow articles on Charts & Dashboards, Visual Basics, Power Pivot Principles, Power Query Pointers 
and Power BI Updates.  We go all Yorkshire in our A to Z of Excel functions series (a good joke, INT it?) and finish off 
with another set of CTRL + SHIFT keyboard shortcuts.

As always, happy reading and remember: stay safe, stay happy, stay healthy.
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With many of us currently “working from home” / quarantined, there are 
only so Zoom / Teams calls and virtual parties you can make before you 
reach your (data) limit.  Perhaps they should measure data allowance 
in blood pressure millimetres of mercury (mmHg).  To try and keep our 

readers engaged, we will continue to reproduce some of our popular Final 
Friday Fix challenges from yesteryear in this and upcoming newsletters.  
One suggested solution may be found later in this newsletter.  Here’s this 
month’s…

It’s time to chart our progress with an introductory series into the world of creating charts and dashboards in Excel.  This month, we consider how we 
may highlight one or more data points in a chart.

You may be aware of the basic concept of ‘Center Across Selection’, the ability to make it look like a group of cells has been merged and centred for 
the purposes of displaying a result.

The advantage of using ‘Center Across Selection’ is that the cells are 
not actually merged, meaning that they can be appropriately formatted 
and styled, as well as not running into common issues when trying to 
navigate and copy/paste around merged cells.

However, one common feature that is frequently complained about as 
being missing from Excel is to be able to do the same thing vertically 
without merging the cells:

Charts are an effective way to presenting data, and one of the more 
informative methods is to highlight specific data points we wish to 

emphasise and make them stand out.  For example, consider the 
following data of quarterly income for a company:

From the provided data, let’s plot a Line Chart as the one below, which has a clear minimum and maximum on Sep-16 and Dec-19, respectively:

So, how is this possible?

Sound easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!

Beat the Boredom Challenge

Charts and Dashboards
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If we wish to highlight these points on the graph, it would be easy enough simply to highlight them and change the format of the points, e.g.

But what if the data changes?  We would have to go back and edit the 
chart points each time there is a new maximum and minimum point.  In 
this situation, let’s create dynamic highlights for the chart.  To do that, 

we’re going to use two “helper” data series: one series is to calculate the 
maximum and the other, the minimum (surprise, surprise):

The ‘Total Income’ series represents the original series data that we used to construct the chart.  Formulae are used to construct the Max and Min 
series; the Max series is calculated with the following formula: 

=IF(G15>=MAX($G15:$T15),G15,NA())

The Min series is calculated with this formula:

=IF(G15<=MIN($G$15:$T$15),G15,NA())

This results in the series only displaying the Maximum and Minimum value in the original chart data, and #N/A for everything else.  Using formulae 
allows the two series to be dynamic, so when there is new data the Max and Min series will update accordingly.

Now that we have the data series, we may include them in the chart.  We can do that by clicking on the original chart, and Excel will highlight the 
relevant data series:

Alternatively, we may right-click on the original chart and select the ‘Select Data’ option.  Then, the ‘Select Data Source’ dialog will appear.  We can 
then add new series by clicking on the ‘Add’ button on the left side of the dialog box:

We can then drag the values down:
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The next step is to fill out the ‘Edit Series’ dialog box accordingly for Max and Min series:

The two additional series are now added and shown in the ‘Legend Entries (Series)’ box:

Do remember to reference the ‘Horizontal (Category) Axis Labels’ if the dates are replaced with sequential integers as illustrated above otherwise 
this may cause charts to display incorrectly in alternative scenarios.

The chart is now shown as the one below, with Max and Min are now chart series and will be changed dynamically depending on the data:

More next month…

We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.  
Let’s see what we Find out this month…

Visual Basics

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Parameter Type Description Values

What Required What we are looking for Any VBA data type, can be a string 
“find me”, or integer 42

After Optional

A single cell after which you want 
the search to begin; this will not 
be searched until the search loops 
around and returns to it.  Defaults 
to the cell in the upper-left corner of 
the range

Range(“A1”)

LookIn Optional What type of thing we want to look 
in; this defaults to xlValues

xlValues for searching values, e.g. 
“51”

xlFormulas for searching formulae, 
e.g. “=A5”

xlComments for searching within the 
Review Comments

LookAt Optional Defines a complete or partial search; 
defaults to xlPart

xlWhole matches the entire 
contents of the field

xlPart matches part of the field

SearchOrder Optional The search order; defaults to 
xlByRows

xlByRows to go across the rows first

xlByColumns to go down the 
columns first

SearchDirection Optional The search direction; the default is 
xlNext

xlNext going forwards in direction

xlPrevious going backwards in 
direction

MatchCase Optional
True makes the search case 
sensitive, whereas the default value 
is False

MatchByte Optional

Used in double-byte language 
searches and irrelevant if the 
language in Excel is single-byte.  
Double-byte languages include 
Korean, Japanese etc.

True to have double-byte characters 
match only double-byte characters

False to have double-byte characters 
match their single-byte equivalents 
(default)

SearchFormat Optional
Searching by format which must 
be set first using Application.
FindFormat

Values are True or False (default)

It’s easy to get lost in a sea of data, but at times we want to find something in particular, be it a word, number or formula.  AutoFilters may help us 
do that.  In Excel, the Find & Select (CTRL + F) function helps us do specific value / formula searches.  But how can we automate this in VBA?

Enter the Find method.

Find finds a specific information in a range, so it can only be used on Range objects.  Let’s have a look at its parameters.
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Let’s start with some data:

This month, we are going to start with the most basic search.  Let's ignore all the other parameters and use their default settings for the time 
being.

Sub TestFind()

    Dim searchRange As Range

    Set searchRange = Range("A1:E10")

    Debug.Print searchRange.Find("observe")

End Sub

We get the following result:

It gives us the value of the cell that has the first match.  However, what if we wanted to know the address of the cell?  As the Find method returns 
a Range result, we can simply use the Address property.

Sub TestFindAddress()

     Dim searchRange As Range

     Set searchRange = Range("A1:E10")

     Debug.Print searchRange.Find("observe").Address

End Sub

But what happens we try to search for something that isn’t in our range?

Sub CantFind()

     Dim searchRange As Range

     Set searchRange = Range("A1:E10")

     Debug.Print searchRange.Find("lost").Address

End Sub

In this instance, we will get an error:
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This is because there was no Range returned.  To prepare for this contingency, a little checking is required to determine if there was a result.  This 
is where the Nothing keyword would be utilised.  Nothing represents the default value of a data type.  For example, a Nothing string would be “”.

As a result, if the Find method cannot return a result, it will return a default value which is Nothing and our code can be adjusted as follows:

Sub CantFindNothing()

    Dim searchRange As Range

    Set searchRange = Range("A1:E10")

    If searchRange.Find("lost") Is Nothing Then

        Debug.Print "lost is not found!"

    Else

        Debug.Print searchRange.Find("lost").Address

    End If

End Sub

using the subroutine from above, it would return “turn up” in cell B1.  
This is because the Find method starts from the upper left corner from 
the range.  Notice how the cursor is on C5.  If we were to press CTRL + F 
in Excel and use the Find dialog, it would start the search from that cell.  
What if we wanted to find a string with “up” after the word “sight”?  How 
can we tell VBA to behave in the same way as the Find dialog?

This is where the After parameter comes in handy.  After takes a Range 
of a single cell to use as the basis to search from.  If you give After a range 
that is bigger than 1x1, then it will generate the following error:

It doesn’t seem to be difficult to Find things using VBA!

If we were to perform a simple search for the string “up” on this Range, 
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After is the second parameter of the Find method, so we can simply pass it after our search string.  We can amend our code as follows:

Sub FindAfter()

    Dim searchRange As Range

    Set searchRange = Range("A1:E10")

    Debug.Print searchRange.Find("up", Range("C5"))

    Debug.Print searchRange.Find("up", Range("C5")).Address

End Sub

This will result in:

Success!  Notice that Find went across the row, which is the default.

Next month, we will continue looking at alternative ways to use Find.

More next time.

We continue our series on the Excel COM add-in, Power Pivot.  This month, we continue to consider how to stop the CALCULATE function from 
overwriting row filters, this time using KEEPFILTERS.

Last month, we looked at using the CALCULATE, FILTER and VALUES functions to stop measures from overriding the row context values.  As a 
reminder, here is how we used the three functions last time: 

Power Pivot Principles
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There is an alternative way to avoid the measure from overriding row context values.  This may be achieved by employing the KEEPFILTERS function.  
We can use the KEEPFILTERS function directly after the CALCULATE function, as in this following example: 

=CALCULATE(
	 [Sales],
	 KEEPFILTERS( 'Product SubCategory'[ProductCategoryKey] = 2 )
	 )

As you can see (below), we have achieved the same result in fewer steps, which is usually the better option when coding!

More Power Pivot Principles next month.

Each month we’ll reproduce one of our 
articles on Power Query (Excel 2010 and 
2013) / Get & Transform (Office 365, Excel 
2016 and 2019) from www.sumproduct.
com/blog.  If you wish to read more in the 
meantime, simply check out our Blog section 
each Wednesday.  This month, we look at 
splitting data using a variety of delimiters.

Let’s have some data for our ever-reliable 
fictional salespeople.  As usual, the data is 
not in a format we would like!

Power Query Pointers
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Basically, we have a list of which salespeople are attending sales 
conferences and who is in charge at each one.  We’d like to put this 
data into a more useful table.  What we would prefer is a list of pairings.  
Therefore, we need to make sure we have a way of identifying which data 

is our sales conference location, which is why we have put ‘Location:’ 
before each city.  We start by creating a query ‘From Table’ in the ‘Get 
and Transform’ section on the ‘Data’ tab.

We want to convert this data into a list of pairings, and the best way for 
us to do this is to tell Power Query what the delimiter is.  However, we 
don’t want to actually split the column up at this point, so we won’t be 

using the ‘Split Column’ on the UI (user interface).  Instead, we will be 
using M code.  The function we’ll be using is

Now, we need to extend this so that we have a long list, with all our lists contained therein.  In order to do this, we’ll convert our table to a list in the 
Transform tab.

Table.TransformColumns(table as table, transformOperations as list, optional defaultTransformation as nullable function, optional missingField as 
nullable number) as table

We have a similar step already created for us to change the type (shown on the previous screenshot), so we may work out what our function needs 
to be.

= Table.TransformColumns(#“Changed Type”, {{“Sales Conferences”, Splitter.SplitTextBy Delimiter(“,”), type text}})

This converts each of our column entries into a list as shown below:
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Our data is now a list of lists, and we need to convert it back to a table so that we may have one long list.  This is made possible by the ability to 
expand the data, as will be shown shortly.

We don’t need a delimiter for this part, so let’s take the defaults.

Now we have our table again, but we have the option to expand our columns, allowing us to view the separated data in one long column.
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Once we ‘Expand to New Rows’ we can see all of our data.

We need to pull out the sales conference locations and to do this, we create a ‘Conditional Column’ from the ‘Add Column’ tab.

This new column will be populated with the location if the text contains ‘Location:’
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We can right-click on the new column and ‘Fill Down’.

This is starting to look like our goal.  Now, we may swap the columns around and remove anything where Column1 contains ‘Location:’.  We then 
rename Column1.

Let’s decide that the ‘Location:’ has been useful to identify the cities, but now it has to go!  We split the column by delimiter (right-click or use the 
transform menu).
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We may now get rid of the Location.1 column and rename the other location column.  ‘Close & Load’ to Excel.

Now to test our query.  In our original Excel data, try adding a new location (Leeds) and a new salesperson (Sam), who will attend the conferences 
in Leeds and London:

After refreshing the query, the new salesperson Sam appears in both locations:
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More next month.

This month’s update includes Power BI metrics, Modeling (sic) updates, deployment pipelines and more.  The full list is as follows:

Reporting

	 •	 Reverse stack order for Stacked Column charts

	 •	 Query performance improvements:

	 	 	 – 	Indexing imported string columns on-the-fly

	 	 	 – 	Pushing Top N filter to DirectQuery sources
	 •	 Power BI Metrics:

	 	 	 – 	Roll ups

	 	 	 – 	New API to retrieve scorecards for administrators

Analytics

	 •	 Quick measure suggestions – experimental feature in Preview

Modelling

	 •	 Relationship editing in the properties pane in Preview

	 •	 DAX Formula bar support for Desktop Model view

Data connectivity and preparation

	 •	 Introducing tenant setting for Power BI Datamarts in Preview

	 •	 Eduframe Reporting

	 •	 Socialbakers Metrics

Service

	 •	 Guest users can now create their own email subscriptions

	 •	 Downloading a PBIX is now available for more scenarios

	 •	 Administration and governance:

	 	 	 – 	Introducing tenant setting for email subscriptions to 	 	
	 	 	 	 external users

	 •	 Deployment pipelines:

	 	 	 – 	Deployment History

	 	 	 – 	Azure DevOps extension now Generally available

	 	 	 – 	Changes to UpdateApp REST API

Developers

	 •	 Custom visuals API version 5.1

Visualisations

	 •	 New visuals in AppSource

	 •	 Zebra BI Tables 6.0

	 •	 Inforiver Enterprise SaaS Edition

	 •	 PowerGantt Chart by Nova Silva

	 •	 Drill Down Network PRO by ZoomCharts

Other

	 •	 Update to release notes.

Let’s now go through each in turn.

Reverse stack order for Stacked Column charts

This update now sees you able to reverse the order in which segments 
are rendered in Stacked Column and Bar charts.  This can be particularly 
helpful to help users match the category groupings of strictly positive 
columns against vertically aligned legends.  Power BI usually draws 

column segments from the zero line upwards, but now those categories 
will be listed in legends in left-to-right, top-to-bottom order.  This can 
sometimes lead to the feeling that their orders have been “reversed.”

Power BI Updates
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With this release, you will find a new Formatting pane option to reverse stack order of your stacked Column and Bar, Area, Ribbon and Combo charts.

The toggle will be off by default.  Turning it on will flip the order in which your segments are stacked.
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It should be noted that due to an issue Microsoft found late in 
development, this feature might not be available in Power BI Service for 
published reports when you read this.  You will still be able to set the 

toggle in Desktop, but report behaviour in Power BI Service will only start 
rolling out mid to late October.

Query performance improvements

INDEXING IMPORTED STRING COLUMNS ON-THE-FLY

There are some query performance improvements of note this month.

Microsoft has been building indices on imported string columns to 
improve query performance of substring searches, i.e. when using the 
ContainsString function, Search function or a filter to look for a string 

literal in a text column.  For example, here is an illustration of a text filter 
set using the Filter pane:

Power BI builds the index when the first query that requests a substring 
search on the column is executed.  The index is built for text columns 
that contain ASCII characters only.  Once the index is built, the substring 

search becomes instant.  You should note that the index is not persisted 
between restarts of Power BI Desktop.
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PUSHING TOP N FILTER TO DIRECTQUERY SOURCES

Power BI Metrics

ROLL UPS

Up until now, when using the TOPN function or a top N filter on a column 
from a DirectQuery source all values of the column would be retrieved.  

The top N filter would then be applied within the DAX engine.  Here’s an 
example of a top N filter set using the Filter pane:

There are two updates to note for Power BI metrics this month.  There are the additions of metric roll ups for current and target values and the ‘Get 
Scorecard’ admin API.

Previously in Metrics, there was no way to automatically aggregate a group of submetrics’ values to the parent metric value.  You could work around 
this by connecting values to data, but before this update, there was no way to automatically roll up manual values – all non-connected metrics 
required check-ins to update the values.

Now, with this release of current and target roll ups, you have the ability to set an aggregation of your submetrics to show in your parent metric.  You 
can select from a few aggregation types:

	 •	 AVERAGE
	 •	 MAX
	 •	 MIN
	 •	 SUM.

To improve performance, Microsoft has changed that behaviour: as of this release, Power BI is pushing the top N filters to DirectQuery sources 
whenever possible.  When the top N filter is constructed on a measure, the measure has to be based upon one of the following aggregations: 

	 •	 COUNT
	 •	 COUNTROWS
	 •	 DISTINCTCOUNT 
	 •	 MAX
	 •	 MIN
	 •	 SUM.
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Whichever aggregation you choose will automatically update the value 
to show the correct aggregation value of its direct submetrics.  Roll ups 
work on connected values as well: if your submetrics are connected to 

data, Power BI will take the aggregations of those values and show it in 
the parent metric.  This makes it easier to stay on top of your manual 
parent metrics.

NEW API TO RETRIEVE SCORECARDS FOR ADMINISTRATORS

Quick measure suggestions – experimental feature in Preview

Power BI this month sees the release of a new administrative 
Application Programming Interface (API) that is instrumental in helping 
administrators with their many administrative tasks.  This is critical in 
examining the state of existing scorecards.

This new get scorecard API is enabled for administrators in Power BI 
and will retrieve all scorecards within an organisation.  The API will 
retrieve scorecard metadata as well as metadata for each metric on the 
scorecards. 

Some time ago, Power BI released a feature called ‘Quick Measures’ that 
allowed Power BI Desktop users to create DAX measures using a built-in 
template instead of writing the DAX from first principles.  This feature 
helped users quickly get started with common measure scenarios.  
However, the number of templates and flexibility of those templates 

left much to be desired.  Now, Power BI has introduced Quick Measure 
Suggestions, which is a new way to assist the creation of DAX measures 
using natural language instead of using templates or writing DAX from 
scratch.
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To enable the feature, you will need to first navigate to the Options menu of Power BI Desktop and turn on the preview switch for ‘Quick measure 
suggestions’:

To access the Quick measure suggestions, select the Modeling tab within the Ribbon and then select ‘Quick measure’:

Then, select the Suggestions tab:
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Here, you can describe the measure you want to create and hit Generate (or the ENTER key) to get DAX measure suggestions:

Don’t just take it for granted though.  You should always validate the DAX suggestions to make sure that it will meet your needs.  If you’re satisfied 
with the suggested measure, you may click the ‘Add’ button to automatically add the measure to your model.

Amongst others, these are just some of the supported measure scenarios:

•	 ‘Quick measure suggestions’ should not be seen as a replacement for learning DAX.  The suggestions provided by the feature are meant 
to help fast track measure creation.  However, you will still need to validate the DAX suggestions because they may be wrong or not 
match your intent

•	 this feature is in experimental preview for users to test and give feedback.  It should be noted that the design and functionality may go 
through significant changes – so don’t rely on it just yet

•	 the feature is powered by a machine learning model that is currently only deployed to US datacenters (East US and West US).  Sadly, if 
your data is outside the US, the feature will be disabled by default unless your tenant administrator enables the ‘Allow user data to leave 
their geography tenant’ setting:

There are limitations though (sadly!).  It should be noted that:

	 •	 Aggregated columns with or without filters

	 •	 Count of rows with or without filters

	 •	 Aggregate per category

	 •	 Mathematical operations

	 •	 Selected value

	 •	 If condition

	 •	 Text operations

	 •	 Time intelligence

	 •	 Relative time filtered value

	 •	 Most / least common value

	 •	 Top N values for a category.
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Certainly worth more than a passing glance!

Relationship editing in the properties pane in Preview

DAX Formula bar support for Desktop Model view

With this update you may now quickly edit relationships in the Properties 
pane.  In the Modeling (sic) view, expand the Properties pane and simply 
click on any relationship line to see all the relationship options.  This new 
relationship editing experience sends minimal queries by having no data 
preview and validating only when you apply changes.  Big data models, 

especially in DirectQuery storage mode, will see the most benefit 
from this streamlined experience.  Should you need to edit using the 
Relationships dialog, this is still available from the Properties pane or by 
double clicking any line, just like before.

The DAX Formula bar is now supported in Desktop Model view.  You may now create and edit measures, calculated columns and calculated tables 
in the Model view on Desktop.

In addition, this update also introduces editing multiple relationships at 
once.  Simply hold down CTRL to select multiple relationships and make 
changes, or even click the DELETE key on your keyboard to delete those 

selected.  You may test it out by going to Files -> Options and Settings -> 
Options -> Preview features and turn on ‘Relationship pane’.
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Introducing tenant setting for Power BI Datamarts in Preview

Eduframe Reporting

Socialbakers Metrics

Guest users can now create their own email subscriptions

Downloading a PBIX is now available for more scenarios

Back in May 2022, Microsoft announced the public Preview of Power BI 
Datamarts, which provided a user-friendly means to ingest data from 
different data sources, extract, transform and load the data using Power 
Query, and then load it into a fully managed Azure SQL database.  Based 
upon feedback from users, Microsoft has announced the introduction of 
AAD-based filtration to the Power BI Datamart preview tenant setting, 

enabling Power BI Service administrators to limit the ability to create 
Datamarts to certain groups or individuals.

Datamart configuration settings may be accessed via the ‘Tenant 
Settings’ tab in the ‘Power BI Admin Portal’:

The Eduframe Reporting connector has been updated:

•	 this update has added custom fields to program editions, planned courses and orders

•	 changing language no longer breaks decimal and currency parsing.

This month sees the release of the new Socialbakers Metrics connector. 

Integrating social media insights alongside the rest of your marketing 
or business intelligence data gives you a holistic understanding of your 
entire digital strategy, all in one place.  With the Socialbakers Power BI 
Connector by Emplifi, you may include social media data from the Emplifi 
Platform in your charts and graphs and combine them with other data 
you own.

The Power BI Connector is a layer between Socialbakers Public API and 
Power BI itself.  It helps you to work with your data directly in the Power 
BI tool. The majority of data and metrics available in the Socialbakers 
Public API are also available in the connector.

From this update, Azure Active Directory Business-to-Business (Azure AD 
B2B) guest users may now create their own email subscriptions in Power 
BI.  Email subscriptions make it easy to stay on top of important reports 
and dashboards by receiving a snapshot in your inbox at customisable 
frequencies.  Instead of requiring users in your organisation to create 
subscriptions on behalf of guest users, Power BI now empowers guest 
users to create their own subscriptions for Power BI reports, dashboards 
and paginated reports they have access to.  

The requirements for a guest user to subscribe themselves to content 
are the same as for any user: either they’ll need a Power BI Pro or 
Premium Per User (PPU) license, or the workspace where the content is 
saved must be backed by a Premium capacity.  For now, guest users may 
only subscribe themselves, not others.

Starting this release, Power BI is introducing multiple options to download a report .pbix file.  Whilst downloading a report .pbix file, you will see 
the following dialog:
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As is shown in the dialog, you may now choose between downloading the 
report including data as well as downloading the report without the data, 
but with a live connection to the data.  You should note that depending 

upon your exact scenario only one option might be available.  In these 
situations, you will see the other option as disabled.  A ToolTip will explain 
why that option is not available, as can be seen in the image below:

However, in most instances you will be able to download the report with a live connection to the data even when downloading the report with the 
data included is not supported.  This unlocks the following situations in which you previously could not download a report .pbix file:

	 •	 download reports created based upon a dataset that is configured for large models

	 •	 download reports created based upon a dataset that is configured for incremental refresh

	 •	 download reports created based upon a dataset that has been modified by using the XMLA endpoint

	 •	 download any .pbix file that is larger than 1 GB
	 •	 downloading usage metric reports.

Administration and governance

INTRODUCING TENANT SETTING FOR EMAIL SUBSCRIPTIONS TO EXTERNAL USERS

Just the one announcement this month…

If your report or dashboard is hosted in a Premium capacity, you can 
include external users as recipients to your email subscriptions. External 
users are users outside of your organisation that have not yet been 
invited to become Azure Active Directory Business-to-Business (Azure 
AD B2B) guest users.  There is now a new tenant setting that specifically 
controls whether email subscriptions can be sent to external users.  With 

the new tenant setting called ‘Allow email subscriptions to be sent to 
external users’, Power BI administrators can control who may send email 
subscriptions to external users, either turning this capability on or off 
for the entire organisation or limiting this capability to specific security 
groups.  The external user email subscription setting may be accessed via 
the ‘Tenant Settings’ tab in the ‘Power BI Admin portal’:
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Deployment pipelines

DEPLOYMENT HISTORY

Three areas to discuss in this section.

If you are having troubles tracking a pipeline’s deployment executions or 
something seems to have changed in your test environment workspace 
and you’re not sure what and / or why, or your last deployment failed, 
and you have no idea how to get its ID for the support ticket, then this 
update is probably for you.

With the new Deployment pipeline feature ‘Deployment History’ all your 
recent months deployments are available to be reviewed, providing 
details on the target environment, the person who ran the deployment, 
the deployed items, the deployment note’s content (if it has been added) 
and more.

‘Deployment History’ has also added the option to add a note as part 
of a deployment process.  This note appears next to its deployment 
history record and assists with providing context when you review past 
deployments.  This note is not editable.

The ‘Deployment History’ page may be accessed through either a 
general entry point (a new ‘Deployment History’ button) or through the 
‘Deployment History’ clickable icon of a deployed stage:

The ‘Deployment History’ page lists the deployments chronologically from newest to oldest:

By default, all the deployments are listed on one list.  However, you can 
narrow your scope to focus on a specific deployed target stage by filtering 
this list using the clickable tabs at the top of the page.

Icons on the left side of each deployment indicate whether the deployment 
succeeded or failed, how many deployed items were different / new / 

same on the deployed stage before the deployment, whether it has a 
note or not and its ID.  Clicking on them expands the deployment record 
and provides additional details such as failure reason, list of the deployed 
items (name and type), the note content and the ID string.
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AZURE DEVOPS EXTENSION NOW GENERALLY AVAILABLE

CHANGES TO UPDATEAPP REST API

New visuals in AppSource

Zebra BI Tables 6.0

Custom visuals API version 5.1

Following the announcement in January of launching the Azure Devops 
(ADO) extension, this update makes this feature Generally Available.  
The ADO extension contains all the API operations available today for 

deployment pipelines so they may be used with Azure pipelines while 
integrating additional capabilities into the release process such as 
automated testing, approvals and more.

Recently, Power BI Apps announced the public Preview of ‘Multiple 
Audiences’ in the Power BI Apps, which adds the capability to manage 
an application’s content by different audiences individually.  Following 

this change, Deployment pipeline UpdateApp REST API was changed to 
exclude the action of adding new deployed items to the application.

The following new visuals are included in this update:

	 •	 KPI CircleCard

	 •	 Plotly Waterfall Chart

	 •	 Text search slicer.

The Zebra BI Tables visual has been updated.  There are now multiple improvements, including further optimisation improvements, new drill options, 
enhanced highlighting settings and bookmarking of all settings.

Microsoft has updated the custom visuals API to version 5.1.  Highlights of this update include:

	 •	 Support for new Format pane.  Using the 5.1 version of the API, you may now define modern Format pane cards, subcategories and new 	
		  properties on custom visuals using the new API ‘getFormattingModel’.  This API is a replacement for the old API ‘enumerateObjectInstances’.  	
		  This should make it easier for report creators to use custom visuals

	 •	 Identity filter API (new).  API 5.1 introduces a new Identity filter API. This API allows you to create a visual that can filter categorical data.  	
		  This is to say it filters the data using data points rather than mathematical expressions.  This is useful for custom visuals that leverage group-	
		  on keys and to allow selections using identities that are opaque.  Additionally, this new API makes it easier to migrate visuals to a newer API

	 •	 Extending the subtotal API for matrix.  Power BI has added a new option to the subtotal API.  The rowSubtotalsType: (‘Top’ or ‘Bottom’) 	
		  allows the visual to fetch the subtotal data on top (before the rest of the data) or bottom (after all the data was fetched).  This is available 	
		  with 5.1 API release

	 •	 New sorting option for Power BI custom visuals.  Previously, Power BI had two sorting options in custom visuals: default and implicit.  With 	
		  the 5.1 API release, a new custom option has been added.  The Custom sort option gives the developers more control over the sorting 	
		  options, such as sorting by multiple fields.
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Zebra BI Tables 6.0 is the first visual that uses a completely new data 
fetching algorithm introduced by Microsoft.  This means it no longer 
need to fetch all the data.  Instead, when a user drills into rows, only the 
necessary data is loaded, which means that the loading time for complex 
matrices with several hierarchies may be c.50 times faster.

The 6.0 version introduces a new highlighting design where you may 

control the row hover settings.  You can change the colour so that it fits 
the needs of your audience best or else turn it off completely.

Options such as expand and collapse, drill down, drill into, expand all 
down or go to next level will assist in analysing your data.  Additionally, 
everything is now bookmarkable so you can seamlessly switch between 
different views within one visual.

Inforiver Enterprise SaaS Edition

PowerGantt Chart by Nova Silva

The Inforiver Enterprise SaaS Edition delivers everything offered by 
Inforiver Premium, along with the following new capabilities:

	 •	 ability to write back data to your own databases (Azure SQL, 		
		  Azure Synapse, SQL Server, Snowflake, Redshift, BigQuery, …) and 	
		  shared drives (OneDrive, SharePoint)

	 •	 scheduling and distributing formatted paginated reports as PDF,  
		  Excel or Screenshot (MHTML) by email and to shared file drives

	 •	 advanced commenting and collaboration at a cell, row and 		
		  column level.

The ability to capture inputs for budget, forecasts, text comments, 
dropdown lists, dates in reading mode even by report viewers for write-
back, snapshot reporting, tasks, notifications and enterprise themes are 
other key highlights.

Earlier this year the PowerGantt Chart was introduced.  Now, it had been 
updated.

One improvement has been to add a custom-date-scale to the 
PowerGantt Chart.  This would significantly increase the number of 
possibilities, because there are unlimited number of custom date / time 

scales such as fiscal years, special week numbers, AM / PM split of the 
day, etc.

Furthermore, you could already include an unlimited number of tasks, 
hierarchy levels and milestones.  Now every user of the PowerGantt can 
also define and include their own custom date scale.

These capabilities are powered by Azure SAAS services which are 
hosted and managed by Inforiver in the public multi-tenant cloud 
architecture.  Inforiver Enterprise Matrix visual may be purchased 
directly with Microsoft as it is integrated with Power BI’s new licensing 
and transactability API.

All of these enterprise matrix capabilities are offered with your data 
encrypted both at rest and in transit.  For customers who have specific 
data residency, security and governance Inforiver also offers private and 
on-premises implementation.
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Drill Down Network PRO by ZoomCharts

You may explore elaborate networks of category-based data using Drill 
Down Network PRO by ZoomCharts.  This custom Power BI visual can 
convert your multi-level pie chart into a network chart that automatically 

detects relations among categories.  Interactive zooming and touch-
driven selections help spot outliers and examine data in detail.
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The main features include:

	 •	 cross-chart filtering: eliminate slicers by selecting data points directly on the charts

	 •	 category-based customisation: choose node type, shape, colour and font
	 •	 link styling: configure ‘from’ and ‘to’ decorations and show link value

	 •	 display up to nine [9] data categories
	 •	 touch-input device friendly: explore data on any device.

Popular use cases include:

	 •	 Accounting and Finance: show cost attribution

	 •	 Human Resources: analyse salary data by department

	 •	 Production: map production volumes by product or factory

	 •	 Sales and Marketing: visualise marketing campaigns.

ZoomCharts Drill Down Visuals are known for interactive drilldowns, smooth animations and their customisation options.  They support interactions, 
selections, custom and native ToolTips, filtering, bookmarks and context menus.  You may use them to create visual, intuitive reports.

Update to release notes

	 •	 OneDrive / SharePoint integration including save and share from 	
	 	 Power BI Desktop will start rolling out to a select few customers 	
	 	 in the coming weeks.  Once sufficient testing has been 	
	 	 performed, it will then roll out to other Office rings, which will 		
	 	 not be until 2023

	 •	 Office installer will start roll out by the end of the year but will 	
	 	 take some time to reach all E5 tenants

	 •	 On Object format and edit will roll out into Preview to a 	
	 	 few select users.  Whilst Microsoft would like to roll this out to all 	

	 	 customers, due to the nature of the change, it has been decided 	
	 	 to delay putting this into production

	 •	 Quick measure suggestions should have shipped in the October 	
	 	 Desktop release in experimental Preview a few of the Metrics 
	 •	 a few of the Metrics features may be slightly delayed

	 •	 what is known as the 2022 Wave 2 release plan has gone through 	
	 	 some updates (mainly on dates) and some carryovers from what 	
	 	 was referred to as Wave 1.  The roadmap should be amended 	
	 	 shortly.

That’s it for this month.  See you in December!

Last but not least, Microsoft wanted to highlight forthcoming updates / highlights for their roadmap.  These include:

The latest updates see the release of Check Performance for Excel web 
users to help speed up your workbooks and dynamic array support for 
Windows users (albeit in Excel for the web and the Desktop Insiders Beta 
presently).  For Insiders using Mac, you can now shape your data using 

the Power Query Editor and manage your storage accounts for first and 
third party profiles.  There are other additions / improvements too, with 
the full list as follows:

Excel for the web

	 •	 Check performance

	 •	 Sharing a section of Excel workbook

	 •	 Dynamic array support in charts

Excel for Windows

	 •	 Modern comments

	 •	 Dynamic array support in charts (Insiders Beta)

Excel for Mac

	 •	 Shape data with Power Query Editor (Insiders Preview)

	 •	 Manage your storage accounts (Insiders Preview).

Let’s plough through.

New Features for Excel

Check performance

Anyone who uses Excel regularly will be familiar with the dreaded file 
bloating phenomenon, where file sizes suddenly increase drastically and 
/ or unexpectedly.  At long last, the Excel Performance team has created 
a new capability to detect and remove unwanted size bloat and speed 
up such workbooks.

Often, a workbook can collect cells that have no data but still contain 
hidden information of little or no use anymore. These cells may have 
had data and formatting to start with, however now they do not have 
any data, but still take up space because they contain formatting.  
Consequently, too many of these cells can cause your workbook to slow 

down or become unresponsive.  As a consequence, this update enables 
you to detect and remove these cells slowing down your workbooks, 
with ‘Check Performance’ – albeit presently available only in Excel for 
the Web.

When you open your workbook, Excel now detects whether your 
workbook contains too many of these unwanted formatted cells.  If it 
does, Excel shows a “Business bar” to launch the ‘Check Performance’ 
feature.  This may be launched manually from Review -> Check 
Performance too.
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Once launched, there are two ways to remove these cells:

	 1.	 by navigating to a sheet in the task pane to review each range of these cells to optimise, and then pressing the ‘Optimize Sheet’ button; or

	 2.	 by pressing the ‘Optimize All’ button to remove all unwanted cells from all sheets in the workbook.

Consider the following example.  Here, we have a file that has a current size of 3.14MB – not too large, but as it turns out, much larger than it 
should be.

Upon opening, the Business bar (yellow bar) highlights the slow workbook and prompts you to ‘Check Performance’.  This may also be accessed from 
the Review tab, as displayed below:

The ‘Workbook Performance’ pane appears and highlights two of the three worksheets may require review, citing a total of four ranges, viz.

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Clicking on the ‘Inventory’ box in the ‘Workbook Performance’ pane yields information on three empty cell ranges that may be optimised and 
prompts with an ‘Optimize sheet’ button (bottom right):

Similarly, the ‘Supplier’ sheet details one range to consider:

Following the prompts and optimising both sheets generates considerable savings in file size:

Here, ‘Check Performance’ has reduced a 3.14 MB file down to 17.5 KB, 
by detecting and removing more than a million unwanted formatted 
cells.  Bearing this in mind, you might think, why doesn’t Excel remove 
these cells in the background without alerting me?  This is because, even 
though the cell has no data, removing its formatting may result in visible 

changes.  For example, removing yellow fill from a cell may reset its fill to 
‘No Color’, which might not be what you want.  Microsoft does not want 
any Excel users to be surprised by visual changes by doing this in the 
background without alerting hence the manual interaction.
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You should note that this new feature will be enabled gradually to 
more and more users over time as Microsoft rolls out the update and 
ensures it is working correctly.  Therefore, if you do not see the ‘Check 
Performance’ button in the Review menu tab, then the feature may not 
be enabled for you yet. 

If you are thinking whether this will come to Excel Windows and Mac 
then we’re way ahead of you.  Apparently, Microsoft is investigating 
other areas contributing to size bloat that they can integrate into 
Check Performance's detection and removal capability and will roll out 
thereafter.  Watch this space. 

Sharing a section of Excel workbook

Whether collaborating through Teams or on the web, you may want to 
share information from a workbook.  You can share the entire workbook, 
but sometimes you may wish to share just a section of the workbook for 
viewing or editing.  With this update, you may easily share with others 

a link to a specific range, table or chart.  First you create a link to the 
shared section of a workbook.  Then you send or make available the link 
to recipients.  Finally, recipients may simultaneously view or edit the 
workbook section.  

To create a shared link to a workbook section:

	 •	 open the workbook in Excel for the web

	 •	 select the range, table or chart

	 •	 right-click the selection, and then select ‘Copy Link to this Range, Table, or Chart’.  The ‘Copy Link’ dialog box appears

	 •	 select ‘People in your organization with the link can edit’.  In the ‘Link settings’ dialog, you may specify: ‘Anyone with the link’, ‘People in 	
	 	 Microsoft with the link’ or ‘People with existing access’.  You may also specify whether recipients have Edit or View permission

	 •	 select Apply

	 •	 select Copy.

The link will now be in the Office Clipboard.  Now that this shared workbook section link is created, recipients may use it in the following common 
ways:
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BROWSER 

TEAMS

Dynamic array support in charts

When a recipient receives the shared link in email, they can select it.  
They may also copy and paste the link into the browser address bar.  The 

workbook will open in Excel for the web.  The range, table or chart will 
be highlighted with a border for easy identification.

Once you have opened or switched to Teams, typically the copied link 
will be shared in the Teams chat with one or more recipients.  The link 
may also be posted in a channel in Teams.

To open the workbook, recipients may select the link from the chat 

or the channel.  The shared range, table or chart will be displayed and 
highlighted with a border for easy identification.  As a tip, right-click the 
workbook section to see additional commands including ‘Edit in Teams’, 
‘Open in Desktop App’, ‘Open in Browser’, ‘Download’ and ‘Copy Link’.

In Excel for the web and Excel Desktop (Insiders Beta), charts will now 
respond to dynamic arrays.  Previously, linking dynamically required 
linking chart source data to an Excel Table (CTRL + T or Insert -> Table) 
but not anymore!

You can now create a chart with a data source range aligned to the 
result of an array formula.  The chart will now update to capture all data 
whenever the array recalculates, rather than being fixed to a specific 
number of data points.  Yippee!

In cells A4:B29 (purposely not placed in an Excel Table), I have entered the results of the Home Cookery & Poisoning (Joint Honours) vocational 
course.  Cell E1 contains an input number that specifies the top “X” students to chart, and the formula 

=INDEX(SORT(A4:B29,2,-1,FALSE),SEQUENCE(E1),{1,2})

has been entered into cell D4 as a dynamic array formula to summarise the said top X students and their respective marks.

Finally, a chart has been inserted linking to the dynamic range (cells D4:E6 in the above illustration) in the usual way (e.g. Insert -> Recommended 
Charts).  Nothing that exciting so far, but then, let’s change the vale in cell E1 to 10 (say):

Finally, it should be noted that opening the workbook by using Excel on the desktop or by downloading the workbook removes the highlight from 
the range, table or chart.

For example, consider the following:
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or even 20:

How cool is that!?  Goodbye opaque formulae using OFFSET and / or INDEX!

Modern comments

Modern comments in Excel for Windows are now built on the React 
Native framework, and you will now find people images are clickable 
showing their contact card details; comments can display both on the 

grid and in the side pane at the same time.  Furthermore, new icons for 
edit, resolve and reactivate are also now available on the card.
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Shape data with Power Query Editor (Insiders Preview)

Yes, we know this was reported last month, but it has been updated!

This feature is available to Insiders using either the Current Channel 
Preview or Beta Channel, running Version 16.64 (Build 22072501) or later. 

When Power Query was first released in Excel for Mac, there was hope 
that it wouldn’t take long for the features to mirror their Window 
counterparts.  It’s taking time, but the capabilities are improving.  
Beginning with the ability to refresh data two years ago, importing data 
was introduced this time last year, so this does seem to be an annual 

event!  As you may imagine, Mac users have desperately requested the 
ability to transform data using the Query Editor, which would provide 
users with the full Power Query experience in Excel for Mac.

Well… it’s getting there!  You may now clean and shape your data with 
hundreds of transformations available in Power Query Editor in Excel for 
Mac. 

To access, on the Data tab, click the Get Data (Power Query) button.

Click Launch Power Query Editor to open the Query Editor.

You can shape and transform your data using the Query Editor similarly to Excel for Windows.  When you’re done, click the ‘Close & Load’ button on 
the Home tab.
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The newly imported data appears in a new sheet.  

Supported data sources include:

	 •	 text, CSV, XLSX, XML and JSON files

	 •	 SharePoint, SharePoint Lists, SharePoint Folders and OData

	 •	 local tables, Tables and ranges

	 •	 Microsoft SQL Server.

You may also access the Query Editor from the data import flow by clicking the Get Data (Power Query) button, choosing a data source, and clicking 
the Next button.

Manage your storage accounts (Insiders Preview)

You may now add and manage first- and third-party accounts and 
services in Excel for Mac, as well as others Office apps for Mac.  The same 
‘Add Storage Accounts’ feature in the Office Mobile apps is now available 
on a Mac.  It is a redesign of the previous ‘Add a Place’ experience in the 

Open tab.  By using this feature, you may now add a SharePoint site, a 
OneDrive or OneDrive for Business account or even a third-party account 
such as Box.
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Microsoft has released an ‘Excel Features Availability’ flyer to detail all of these items:

You can find the updated version of this grid with the interactive links at aka.ms/ExcelFeaturesFlyer. 
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The INT function is a good ol’ fashioned Yorkshire function, INT it?  INT rounds a number down to the nearest integer.  

It employs the following syntax to operate:
INT(number).

The INT function has the following argument:

	 •	 number: this is required and represents the real number you wish to round down to an integer. 

It should be noted that:

	 •	 negative numbers are still rounded down: this has the effect of rounding up in order of magnitude, e.g. INT(-9.001) is equal to -10 (see 	
		  diagram above)
	 •	 due to floating point errors, sometimes INT and the ROUND functions do not work as expected.  Sometimes, you may need to experiment to 	
		  get the result required.

Please see our example below: 

The A to Z of Excel Functions: INT

Sometimes, you wish to forecast what comes next in a sequence, i.e. make a forecast.  There are various approaches you could use:

	 •	 Naïve method: this really does live up to its billing – you simply use the last number in the sequence, e.g. the continuation of the series 8, 17, 	
		  13, 15, 19, 14, … would be 14, 14, 14, 14, …  Hmm, great

	 •	 Simple average: only a slightly better idea: here, you use the average of the historical series, e.g. for the continuation of the series 8, 17, 13, 	
		  15, 19, 14, … would be 14.3, 14.3, 14.3, 14.3, … 

	 •	 Moving average: now we start to look at smoothing out the trends by taking the average of the last n items.  For example, if n were 3, then 	
		  the sequence continuation of 8, 17, 13, 15, 19, 14, … would be 16, 16.3, 15.4, 15.9, 15.9, … 

The A to Z of Excel Functions: INTERCEPT
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	 •	 Weighted moving average: the criticism of the moving average is that older periods carry as much weighting as more recent periods, which 	
		  is often not the case.  Therefore, a weighted moving average is a moving average where within the sliding window values are given different  
		  weights, typically so that more recent points matter more.  For example, instead of selecting a window size, it requires a list of weights  
		  (which should add up to 1).  As an illustration, if we picked four periods and [0.1, 0.2, 0.3, 0.4] as weights, we would be giving 10%, 20%, 30%  
		  and 40% to the last 4 points respectively which would add up to 1 (which is what it would need to do to compute the average).

		  Therefore the continuation of the series 8, 17, 13, 15, 19, 14, … would be 15.6, 15.7, 15.7, 15.5, 15.6, …

All of these approaches are simplistic and have obvious flaws.  We 
are using historical data to attempt to predict the next point.  If we go 
beyond this, we are then using forecast data to predict further forecast 
data.  That doesn’t sound right.  We should stick to the next point.  Since 
we are looking at a single point and we can weight the historical data 
by adding exponents to the calculation, this is sometimes referred to as 
Exponential Single Smoothing.

A slightly more sophisticated method is called regression analysis: well, 
that takes me back!  This is a technique where you plot an independent 
variable on the x (horizontal axis) against a dependent variable on the 
y (vertical) axis.  “Independent” means a variable you may select (e.g. 
“June”, “Product A”) and dependent means the result of that choice or 
selection.

Do you see?  You can draw a straight line through the data points.  There 
is a statistical technique where you may actually draw the “best straight 
line” through the data using an approach such as Ordinary Least Squares, 
but rather than attempt to explain that, I thought I would try and keep 

you awake.  There are tools and functions that can work it out for you.  
This is predicting a trend, not a point, so is a representative technique 
for Exponential Double Smoothing (since you need just two points to 
define a linear trend).

Of course, this technique looks for a straight line and is known as linear 
regression.  You may think you have a more complex relationship (and 
you may well be right), but consider the following:

	 •	 Always split your forecast variables to logical classifications.  	  
		  For example, sales may be difficult to predict as the mix of  
		  products may vary period to period, for each product, there may  
		  be readily recognizable trends

	 •	 If the relationship does not appear to be linear, try plotting log x  
		  against log y.  If this has a gradient of two then y is correlated  
		  with x2; if the gradient is three, then y is correlated with x3 etc. 

One way of defining this is with the INTERCEPT (i.e. where the trendline 
cuts the y-axis, or the value when x is zero [0]) and SLOPE (i.e. the 
gradient) functions.

The INTERCEPT function calculates the point at which a line will intersect 
the y-axis by using existing x-values and y-values.  The intercept point is 
based on a best-fit regression line plotted through the known x-values 
and known y-values (as described above).  You should use the INTERCEPT 
function when you want to determine the value of the dependent 
variable when the independent variable is zero (0).  For example, you can 
use the INTERCEPT function to predict a metal's electrical resistance at 
0°C when your data points were taken at room temperature and higher.

The INTERCEPT function employs the following syntax to operate:

INTERCEPT(known_y’s, known_x’s).

The INTERCEPT function has the following arguments:

	 •	 known_y’s: this is required and represents the dependent set of observations or data
	 •	 known_x’s: this is also required and denotes the independent set of observations or data. 

Once you have worked it out, you can calculate the gradient (m) and where the line cuts the y axis (the y intercept, c).  This gives you the equation 
of a straight line:

y = mx + c

Therefore, for any independent value x, the dependent value y may be calculated – and we can use this formula for forecasting.

For example, if you plotted your observable data on a chart, it might look something like this:
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It should be noted that:

	 •	 the arguments should be either numbers or names, arrays or references that contain numbers

	 •	 if an array or reference argument contains text, logical values or empty cells, those values are ignored; however, cells with the value zero are 	
		  included

	 •	 if known_y's and known_x's contain a different number of data points or contain no data points, INTERCEPT returns the #N/A error value

	 •	 The equation for the intercept of the regression line, a, is: 

		  where the slope, b, is calculated as:

		  and where x and y are the sample means AVERAGE(known_x's) and AVERAGE(known_y's)

	 •	 the underlying algorithm used in the INTERCEPT and SLOPE functions is different than the underlying algorithm used in the LINEST function.  	
		  The difference between these algorithms can lead to different results when data is undetermined and collinear.  For example, if the data 	
		  points of the known_y's argument are zero (0) and the data points of the known_x's argument are one (1): 

			   –	 INTERCEPT and SLOPE return an #DIV/0! error.  The INTERCEPT and SLOPE algorithm is designed to look for one and only one answer, 	
				    and in this case there can be more than one answer

			   –	 LINEST returns a value of zero (0).  The LINEST algorithm is designed to return reasonable results for collinear data, and in this case at 	
				    least one answer can be found.

Please see our example below: 

First introduced in Excel 2007, the INTRATE function will calculate the interest rate for a fully invested security.  For example, it is particularly useful 
in calculating the interest rate of an unlisted bond. 

The INTRATE function employs the following syntax to operate:

INTRATE(settlement, maturity, investment, redemption, [basis])

The A to Z of Excel Functions: INTRATE
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It should be further noted that: 

	 •	 Microsoft Excel stores dates as sequential serial numbers so they can be used in calculations. By default, January 1, 1900 is serial number 1,  
		  and January 1, 2008 is serial number 39448 because it is 39,448 days after January 1, 1900

	 •	 dates should be entered using the DATE function, or as results of other formulae or functions.  For example, use =DATE(2020,2,29) for the  
		  29th of February, 2020.  Problems may occur if dates are entered as text

	 •	 the settlement date is the date a buyer purchases a coupon, such as a bond.  The maturity date is the date when a coupon expires.  For  
		  example, suppose a 30-year bond is issued on January 1, 2008, and is purchased by a buyer six months later.  The issue date would be  
		  January 1, 2008, the settlement date would be July 1, 2008, and the maturity date would be January 1, 2038, 30 years after the January 1,  
		  2008, issue date

	 •	 settlement, maturity and [basis] are truncated to integers
	 •	 if settlement or maturity is not a valid date, INTRATE returns the #VALUE! error value
	 •	 if investment ≤ 0 or if redemption ≤ 0, INTRATE returns the #NUM! error value
	 •	 if basis < 0 or if basis > 4, INTRATE returns the #NUM! error value
	 •	 if settlement ≥ maturity, INTRATE returns the #NUM! error value
	 •	 INTRATE is calculated as follows:

		  where:

			   – 	 B = number of days in a year, depending upon the basis
			   – 	 DIM = number of days from settlement to maturity.

Please see our final example for this month below:
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The INTRATE function has the following arguments:

	 	 •	 settlement: this represents the security's settlement date.  The security settlement date is the date after the issue date when the security 	
			   is traded to the buyer

	 	 •	 maturity: this is the security's maturity date, i.e. when the security expires
	 	 •	 investment: this is the amount invested in the security

	 	 •	 redemption: this is the amount to be received at maturity
	 	 •	 basis: the type of day count basis to use.  This is the only optional argument.  There are five options:

More Excel Functions next month.

Basis Day count basis

0 or omitted Day count basis

1 US (NASD) 30 / 360

2 Actual / actual

3 Actual / 360

4 Actual / 365

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

To recap, the problem we had for this month’s newsletter was the inability of the ‘Center Across Selection’ feature to vertically align content in cells.  
We highlighted that we were unable to ‘Center Across Selection’ a selection of cells vertically to have them appear merged and aligned vertically:

Beat the Boredom Suggested Solution

Camera Solution

The first solution we are going to present uses the ‘Camera’ command in Excel.  The Camera command can be accessed by enabling it in the 
‘Customize the Quick Access Toolbar’ through Excel options:

With the Camera command enabled we can take a ‘picture’ of the cells we wish to have vertically aligned, then create a picture on Excel.  We can 
then rotate the picture so that the text is aligned vertically.
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However, this method has its drawbacks.  Formatting the picture to be aligned with the cells is tricky.  Any attempts at alignment cause the cells to 
look odd:

The picture also does not respond to adding or removing columns, and changing the dimensions for the cell that was originally referenced breaks 
the picture:

Shapes Solution

We can use shapes to achieve vertical alignment without running into any of the problems encountered from using a picture from the Camera 
command.  The first step is to create a ‘Rectangle’ shape:
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Draw the rectangle out, then click on it and reference the cell we wish to have aligned vertically (B2):

Centre the text using the alignment settings on the Home tab:

Place the rectangle over the cell it is currently referencing (B2), and rotate the rectangle so that we have it vertically aligned and place it over the 
cells that we wish to cover (B2:C4):

Once snapped to grid, the shape will respond to adding or removing columns or rows, and resize itself accordingly:

Do note that if you wish to change what the cell says we have to use the arrow keys on the keyboard to navigate to the cell as clicking on the cell with 
the mouse will result in Excel selecting the shape instead.

Until next time.
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month, we look again at the CTRL 
and SHIFT keys, but this time combined with various special characters that Excel uses:
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Sydney Address:	 SumProduct Pty Ltd,  Suite 803, Level 8, 276 Pitt Street, Sydney NSW 2000
New York Address:	 SumProduct Pty Ltd, 48 Wall Street, New York, NY, USA 10005
London Address:	 SumProduct Pty Ltd, Office 7, 3537 Ludgate Hill, London, EC4M 7JN, UK
Melbourne Address:	SumProduct Pty Ltd, Ground Floor, 470 St Kilda Road, Melbourne, VIC 3004
Registered Address:	SumProduct Pty Ltd, Level 14, 440 Collins Street, Melbourne, VIC 3000

Keystroke What it does
CTRL + SHIFT + A Insert arguments into a formula
CTRL + SHIFT + B Address Book (only when emailing not as an attachment)
CTRL + SHIFT + F Font face
CTRL + SHIFT + L Toggle AutoFilter
CTRL + SHIFT + O Select Comments
CTRL + SHIFT + P Font size
CTRL + SHIFT + T Toggle Total Row
CTRL + SHIFT + U Expand / collapse Formula bar

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Location Course Date Date Duration Duration

Online (Australia) Power Pivot, Power Query and Power BI 9 - 11 Nov 2022 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 16 Nov 2022 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 1 Day

Online (Australia) Financial Modelling 17 - 18 Nov 2022 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 7 - 9 Dec 2022 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 14 Dec 2022 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 1 Day

Online (Australia) Financial Modelling 15 - 16 Dec 2022 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 2 Days

Upcoming SumProduct Training Courses - COVID-19 update
Due to the COVID-19 pandemic that is currently spreading around 
the globe, we are suspending our in-person courses until further 
notice.  However, to accommodate the new working-from-home 
dynamic, we are switching our public and in-house courses to 
an online delivery stream, presented via Microsoft Teams, with 
a live presenter running through the same course material, 
downloadable workbooks to complete the hands-on exercises 
during the training session, and a recording of the sessions for 

your use within 1 month for you to refer back to in the event 
of technical difficulties.  To assist with the pacing and flow of 
the course, we will also have a moderator who will help answer 
questions during the course.

If you're still not sure how this will work, please contact us at 
training@sumproduct.com and we'll be happy to walk you 
through the process.


